## Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Update Group</td>
<td>4-10</td>
</tr>
<tr>
<td></td>
<td>Importing Reports</td>
<td>4-11</td>
</tr>
<tr>
<td></td>
<td>Printing Reports</td>
<td>4-11</td>
</tr>
<tr>
<td></td>
<td>Publishing Reports</td>
<td>4-12</td>
</tr>
<tr>
<td></td>
<td>Emailing Reports</td>
<td>4-13</td>
</tr>
<tr>
<td></td>
<td>Evaluated Fields</td>
<td>4-14</td>
</tr>
<tr>
<td><strong>Chapter 5</strong></td>
<td>Using EFT Transmittal</td>
<td>5-1</td>
</tr>
<tr>
<td><strong>Chapter 6</strong></td>
<td>Using Check Notification</td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>Formatting Numeric Fields</td>
<td>6-3</td>
</tr>
<tr>
<td></td>
<td>Formatting Date Fields</td>
<td>6-4</td>
</tr>
<tr>
<td><strong>Chapter 7</strong></td>
<td>Using Wells Fargo Interface</td>
<td>7-1</td>
</tr>
</tbody>
</table>
Chapter 1 - Introduction

The APC Application Suite is designed as an add on to the FundWare® accounting system. It is a windows application with versions available for Windows ’95, ’98, ’2000, NT and XP. Some of the features of the software are:

- Define forms for use with standard reports. Portrait, landscape, wide, narrow and other forms can be defined.
- For check printing, accounts payable or payroll, MICR fonts are provided so that you can use blank stock forms for printing.
- The ability to cause duplicate information to be printed on a form. You can have a stub / stub / check format for your accounts payable checks.
- Full access to graphic images and line drawing. Add your logo and other images to the resulting forms.
- Full color printer support so that text and images can be printed on color printers.
- Full font style and size selection on a field by field basis. Decimal alignment and other justification can also be specified on a field by field basis.
- Check signature logic that allows you to specify when a signature or any other element in the form is to be printed.
- Generate any report as a PDF (Portable Document Format) and send as an email attachment or save for later viewing.

How The System is Constructed

APC Application Suite is constructed as a series of tools that provide you with the ability to manage all aspects of printing and reporting from your accounting system. The core piece of the application is the Advanced Printer Control component. This component is divided into two pieces:

Form Setup Utility Use this utility to format and design the form to be produced.

Printer Control Use this utility to print the accounting system reports using the forms you have designed.

Each of these components is a separate program that operates off of a central form database. If desired, the printer control portion can be installed on any ones desktop, while only those people who need to change how a form looks would have the Form Setup utility.

➢ Tip: If you are using the Advanced Printer Control to print checks from blank check stock, be sure to give yourself time to verify acceptance of the printed checks by your bank. Most banks require several sample checks prior to printing your own, to insure that the check readers can read the encoded routing information at the bottom of the check.
Enhance your reports by purchasing the additional components listed below:

**Web Reporter**  
*Web Reporter* sorts and indexes any FundWare® report. It is used in conjunction with the *Advanced Printer Control* module to format and print the resulting formatted report. Features of the software are:

- Define an unlimited number of rules to be used for sorting and indexing reports.
- Multiple reports can be combined into a single consolidated report.
- Group reports so that the collating process is a one step operation.
- Automatically produce a table of contents page for reports. Easing distribution and publishing of final reports.
- Automatically email the generated reports as a PDF.

**EFT Transfer**  
The *EFT Transfer* component produces an electronic transmittal using the NACHA format accepted by most banks for payment of vendors. *EFT Transfer* watches for checks produced within *Advanced Printer Control* and can be defined to automatically print a remittance advice instead of a check. A single push of a button produces the transmittal file for the bank.

**Check Notification**  
*Check Notification* provides you with a list of checks that have been produced and electronically notifies your banking system of this list. This feature gives further fraud protection by enabling you to give notification of the checks you want cleared to your bank. This service is provided by some banks and may be called “Positive Pay”.

**Wells Fargo Interface**  
The *Wells Fargo Interface* provides a list of checks produced to the Wells Fargo banking system. This is a specific version for this bank. Use the *Check Notification* component for all other banks.

The following components are designed specifically for Florida Childcare providers. Use them to simplify interfacing the state tracking system with your accounting system. They are provided as separately licensed products, but require *Advanced Printer Control* to properly operate.

**FL Childcare Providers – EFT**  
*FL Childcare Providers – EFT* generates the transmittal of Vendors who have chosen to be paid electronically.

**FL Childcare Providers – AP Wizard**  
*FL Childcare Providers – AP Wizard* generates obligations for payment by your accounting system. *FL Childcare Providers – AP Wizard* automatically logs EFT payment information for the *FL Childcare Providers – EFT* component.
Chapter 2 - Installation and Setup

Installing the Software

If the product has been provided on CD, place the CD into the CD drive of your computer and select *APC Application Suite* from the menu. If the system has been provided on diskette, place the first product diskette into your floppy drive. From your program manager, run “A:\Setup” or “B:\Setup”. The system will step you through the installation process.

1) **Choose Location where the Software is to be installed**

![Choose Destination Location](image)

- **Note:** When installing the *Advanced Printer Control* in a multi-user environment, choose a network folder name. This way other users may access the system.

- **Note:** If installing an additional component, always install all components into the same folder.

- **Note:** *Never* have more than one copy or version of the software installed. This will cause conflicts and you will potentially lose the forms you have defined.
2) Choose the components to be installed.

In the options list below, choose the components that you would like to have installed. Each application you choose requires a separate license to operate. The disk space fields reflect the requirements of the options you have selected.

- Sample Forms: 168 k
- Sample Reports: 256 k
- Advanced Printer Control: 822 k
- Web Reporter: 411 k
- EFT Transfer: 84 k
- Check Notification: 96 k
- Wells Fargo Interface: 77 k

Disk Space Required: 822 k
Disk Space Remaining: 160305 k

➢ Note: Install the Sample Forms and Sample Reports only if you are evaluating the software or if this is the first time you are installing the software. The sample forms will give you a starting point for designing your own forms.

Install the other components only if you have purchased them and have been provided a license for their use.
3) **Register the software**

Each component of the software may be registered at any time. Once registered, the full functionality of the component is activated. To register, press the “Register” button from each of the components main window. When pressed a window similar to the following is displayed:

Enclosed with any purchased software is a product registration sheet containing the information that needs to be entered into this window. Enter all spaces, letters and numbers EXACTLY as they are printed on the sheet.

Each component has a separate license and must be registered individually.
Network Installation

When installing in a network environment, the simplest method is to install each of the *APC Application Suite* components into a sub directory on a networked drive. This can be a separate directory or a sub directory where the accounting software has been installed. Once installed, for those workstations needing access to the application program, you will need to add a shortcut to the computer desktop. Do this by first minimizing or closing all windows on the workstation. Then press the right mouse button over an empty location on the workstation desktop. Select New ➔ Shortcut from the displayed menu. For the first displayed window, use the browse button to find the file “pcs.exe” where *APC Application Suite* components were installed.

For the name of the program, use “Form Setup Utility” or any name you find appropriate. Repeat this process for each workstation requiring access to the application.

Other shortcuts that you can create:

- **Printer Control**  
  - Pcp.exe
- **Web Reporter**  
  - Pcc.exe
- **EFT Transfer**  
  - Eft.exe
- **Check Notification**  
  - Arp.exe
- **Wells Fargo Interface**  
  - Wfi.exe
Sending Reports as Email Attachments

Provided with the software is a printer driver that allows the generation of a report as a PDF. A PDF (Portable Document Format) report can be read by any user having a PDF viewer. These viewers are generally available at no charge from the internet. To take advantage of this feature, each work station must have the “PDF Xchange” printer installed. This is ONLY provided on the installation CD. Prior to the installation of the PDF Xchange printer, the printer selection appears as follows:

From this selection, you can choose any available printer and optional preview the report. Once installed this selection changes to:

Now you can print the report, send the report as an email attachment or save the report as a PDF. The saved PDF’s can be printed later or published to a web site for download.

➢ Note: The PDF Xchange printer works ONLY with an AccuFund application. This is a standard feature for all of our applications.
Security Features

Controlling access to the check stock and securing the magnetic ink toner cartridge (if printing the entire form) are your first levels of security. Within Advanced Printer Control are several features that will help you control who has access to forms.

One method of controlling forms is to set a password on any form whose use is to be restricted. Using the Form Setup program select the form you wish to add a password and press the “Change” button. Check the Password field and enter a password in the associated field. When entering a password, “*” will be displayed for the entered characters. Now, when printing reports using the restricted form, the password will need to be entered before the report will be produced.

Another way of controlling forms is to place any special graphical images, such as signatures, into a separate directory. Then using the security from within the operating system (NT Server, Novell, etc.) restrict the access to that directory to only those people who are allowed to print these graphical images. Now, when designing the form, change the properties of the graphical image so that the path to the image points at the restricted directory. Anytime the form is used the Advanced Printer Control program will attempt to access the image from the restricted directory. If no access is allowed because of security restrictions, the image will not be printed.

If you are using the NT operating system or Windows ‘2000, a final method for restricting access to controlled forms can be done by restricting the access to the Form Setup program. Using your network administration tools create a group and assign those users that should be able to change forms to the newly created group. Then, select the “pcs.exe” file from the menu where the Advanced Printer Control programs were installed. Change the properties of the selected file and choose the “Securities” tab. Using the “Permissions” button remove the everyone group and then add the newly added group with a permission type of at least read. Other operating systems may have a similar function that can be used to provide the same functionality.
Using the Software for the First Time

The first time that the form setup utility is used the system will ask you for a name and password of the application administrator. Anytime this user abbreviation is entered into the form setup utility, full access to the system (all options) will be allowed. Additional users and administrators can be defined by inserting them into the “User” tab of the form setup utility.

![Setup Initial User](image)

This wizard will setup the initial user for doing form setup. The user entered here will be able to do all functions within the Advanced Printer Control. Additional users can be defined with more restrictive security from the user tab.

User: admin
Name: Application Administrator
Password: ********
Password Again: ********

Please remember the user and password. These values will need to be entered the next time that you use this form setup utility.

Once the OK button has been pressed, the system will automatically display the login window. This is the only time that Setup Administrator window will appear. The user abbreviation and password will then be used to login into the system. Once logged in, use the system administrator to define the other users that will be using the application.
Chapter 3 - Using Advanced Printer Control

After installing and registering the software, you are ready to begin creating and designing your first form. To do this quickly and easily, follow these steps:

1. Generate a sample report from your accounting system. Make sure that there is more than one form in your sample.

2. Start the Printer Control program and browse the generated report.

3. Leaving the browse window open, log into the Form Setup Utility. Using the form setup utility, insert a new form (or copy one of the samples and use it as a starting point). Make sure the form is defined as a “Parsed” form. Then assign the overall form properties in the “Form Setup” tab.

4. Press the “Design” button to start the graphical report designer. Start by dragging those elements that are constants (your address, logo, lines, boxes, etc.) from the toolbar onto the design.

5. After placing the constants onto the form, toggle back to the browse window. Highlight those fields that you want placed in the form and use the right mouse button to copy the field to the clipboard. Then toggle back to the designer window and paste the field back into the form design. You may have to change some of the field properties (number of lines, etc.) This can be done by selecting the field and using the right mouse button. Select the properties menu option.

6. Once you have all the fields populated into the form close the designer window and press OK to accept the form. Toggle back to the browse window and press the print button to print a sample of the form. If you need to make changes toggle back to the form setup utility and change the form. Repeat steps 4, 5 and 6 until you have the form the way you want it.

For more information about the specific functions available with the software see the additional documentation provided by this manual.
Printer Control

The Printer Control program automatically lists all available reports for the currently selected directory. If you are using the “Advanced Security System” the directory will be the one specified within the FundWare® security system. If not using the “Advanced Security System”, the directory is where all of your data is located.

All report processing functions, for forms and standard reports, are accessed via the Printer Control program. By selecting a report and pressing an associated button the corresponding function is invoked. You may select more than one report for processing by holding the control key and clicking on one or more reports.

The “Browse” button lets you review the results of a filed report a page at a time.

The “Print” button allows you to print the standard report or form. How the report is to be formatted (paper size and orientation) is determined from the selected form.

When the “Delete” button is pressed, the currently highlighted report is deleted. You will be asked to confirm the deletion of a report.

Press the “Close” button to close the program and return to windows.

Pressing the “About” button will display program information regarding to whom this product is licensed, as well as current version information. If your product is not yet registered this button will read “Register”. Use it to register the software.

Note: Pressing F5 will refresh your filed report list.

Selecting the “By Name” tab sorts the reports by name. Selecting the “By Division” tab sorts the reports by division number.
File Menu

There are several options available from the File menu.

Changing from the default printer can be accomplished by selecting the File ⇒ Printer Setup option.

The list of available reports can be further refined by selecting the File ⇒ Filter Reports option. Here a report selection mask may be entered. For example, CS*.L* will select only those reports beginning with CS.

The directory where the filed reports are listed can be changed at any time by using the File ⇒ Change Directory menu option. Pressing the “…” button from this window will allow you to search for the filed reports directory on your system.
Browsing Reports

After highlighting a report and pressing the “Browse” button, the following window is displayed.

From this window you can scroll through the report and find specific results. Use any of the following:

- Use the “Close” button to return to the Printer Control window.
- Print the current report. The “Print” button operates the same as the print button in the Printer Control window.
- Display Font Size: Enter the size or use ▼ to adjust the size of the displayed text.
- Page: Enter the page or use ▼ to change the current page being displayed.
Copying Fields From the Browse Window

From the “Browse Reports” window information from the report can be copied and then pasted into another windows application or into the report designer. To use this feature highlight the text desired and press the right mouse button. The following menu is displayed:

Choose “Copy” to copy information to the windows clipboard. Choose “Copy Field” to copy a parsed field to the windows clipboard so that it can be pasted into the report designer.

For more information see the Report Designer section in Chapter 3.

Printing a Report

Pressing the “Print” from either the Printer Control window or the Browse Report window will cause the following window to be displayed.

Using the list of available forms select the format for the resulting report. The forms themselves are defined by the Form Setup program.

If the form requires a password it must be entered before the report can be printed.

You may selectively print specific pages from the report.

From the list of available printers choose where the report is to be sent.

Checking the preview option will preview the resulting report. The preview will include any additional graphical images and other reformatting that has been designed into the form. After previewing the report you can send the report to the printer.
Form Setup Utility

The Form Setup Utility is a separate program where forms are defined and maintained. All security related information can be defined and/or reviewed. In addition, a report may be produced showing the properties for any defined report.

A series of tabs are used to separate the different portions of the Form Setup Utility:

- **Forms**: Lists all the currently defined forms. Both standard reports and parsed forms are defined here.
  - **Tip**: Samples of Accounts Payable and Payroll checks are included with the installed product. These samples can be used as a starting point for developing your own forms.

- **Logged Checks**: For those forms that are logged, an entry is made each time the form is used to print a report. In addition the detail of the individual form is also available for review.

- **Payees**: In addition to tracking the use of each form, a log is created showing the individual Payees and the associated dollar amount. Use this tab to review by Payee logged forms.

- **Users**: Select this tab if you want to review or change who has access to the Form Setup utility.
  - **Note**: The tabs and the information displayed in each tab is determined by your security level. See the Defining Users section of this document for more information.
Forms Tab

The forms tab lists both standard reports and defined forms. The distinction between a standard report and a form is based on whether the report is “parsed”. Parsing a report causes the filed report generated by the accounting system to be read, a page at a time, and a set of formatting rules applied.

The following functionality is provided from this tab:

These maintenance buttons are used to look at (view) a form, send a form to someone else (export), add (insert) a new form, create a duplicate (copy) of an existing form, or remove (delete) a form that is no longer used.

➢ **Tip:** Use the “Copy” function to create a new form from an existing form. This will shortcut the time required in setting up new forms.

The list function provides you with a way to print a report showing all or a selected form’s properties.

The “Import” button imports a designed form that has been exported. The “Import” and “Export” buttons allow forms to be shared between *Advanced Printer Control* software users.

The “Options” button provides access to the *Endowment Management Suite*.

Press this button when you have completed all your changes and to close the program.

Pressing this button will display program information regarding who this product is licensed to as well as current version information.
Update Options Window

Checking the Endowment Management option shown and entering the required fields activate this feature. Additional information will need to be entered into the form to properly retrieve fund and donor information.

- **Endowment Management**: Check this option to activate the interface with your *Endowment Management Suite*.
- **Path**: Enter the path where your *Endowment Management Suite* is located.
- **Fund**: Enter the number of the sample fund that will be used while testing reports.
- **Donor**: Enter the donor number to be used while testing reports.
- **Trace Report Generation**: Check this option to trace the generation of reports.
Logged Checks Tab

The logged checks tab lists all usage of logged forms. This information is kept chronologically in descending date order so that you can review the latest information first. The information shown here is for the application administrator.

Use the "Delete" button to remove logged forms. This should ONLY be done by the application administrator.

Pressing the "View" button displays the detail associated with the form usage.
Payees Tab

As the checks are logged a payee list is also created. With this tab you can review by payees all usage of logged forms. This information is in Payee order.

<table>
<thead>
<tr>
<th>Payee</th>
<th>Name</th>
<th>City</th>
<th>State</th>
<th>Zip Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC Hardware, Inc.</td>
<td>ABC Hardware, Inc.</td>
<td>P.O.</td>
<td>Box</td>
<td>778800</td>
</tr>
<tr>
<td>American Business Insurance Child Care Providers, Inc.</td>
<td>American Business Insurance Child Care Providers, Inc.</td>
<td>4438</td>
<td>W.</td>
<td>Fullerton 778800</td>
</tr>
<tr>
<td>Ms. Frederika Loomis</td>
<td>Ms. Frederika Loomis</td>
<td>33</td>
<td>Aspen</td>
<td>Drive</td>
</tr>
</tbody>
</table>

Pressing any of the maintenance buttons “Insert”, “Change” or “Delete” allows you to manually maintain the list of payees. Normally the payees listed here would be automatically added as checks are produced and logged. Pressing the “View” button displays the following window:

Payee will be viewed

Payee: ABC Hardware, Inc.
Name: ABC Hardware, Inc.
Street 1: 
Street 2: 
City: P.O.
State: Box
Zip Code: 778800

Checks

<table>
<thead>
<tr>
<th>Date</th>
<th>Type</th>
<th>Name on Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/31/1998</td>
<td>EFT</td>
<td>ABC Hardware, Inc.</td>
</tr>
<tr>
<td>3/31/1998</td>
<td>check</td>
<td>ABC Hardware, Inc.</td>
</tr>
</tbody>
</table>
The logged checks are kept chronologically in descending date order so that you can review the latest information first.

Pressing the “Change” button allows you to correct and change any payee information. In addition, you can define the EFT information for this payee.

➢ Note: To generate the EFT Transmittal for the bank, you must purchase the EFT component for Advanced Printer Control.

<table>
<thead>
<tr>
<th>Checks</th>
<th>EFT Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Type</td>
<td><img src="Image" alt="Check" /> <img src="Image" alt="Prevote" /> <img src="Image" alt="EFT" /></td>
</tr>
<tr>
<td>Account Type</td>
<td><img src="Image" alt="Checking" /> <img src="Image" alt="Savings" /></td>
</tr>
<tr>
<td>Bank DFI</td>
<td>11111111</td>
</tr>
<tr>
<td>Bank Account</td>
<td>222-333</td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
</tbody>
</table>

- **Payment Type** Choose the type of payment for this payee. By default, checks are printed for all payees. Before beginning electronic payment of vendors, a prenote must be sent to the bank. This verifies that the bank routing (DFI) and account numbers are correct. Upon transmittal of the NACHA file, prenote vendors can be automatically converted to EFT.

- **Account Type** Choose the type of account (saving or checking) where payment is being deposited.

Bank DFI Enter the bank routing number for this payee.

Bank Account Enter the bank account number for this payee.

Comment Enter any additional comment with regard to this payee.
**Users Tab**

The users tab provides access to the security portion of the form setup utility. From here the application administrator can create new users and determine what portion of the form setup utility that can be used.

Pressing any of the maintenance buttons “Insert”, “Change” or “Delete” allows you to maintain the list of users:

Enter a user abbreviation, name, assign a password and check off the parts of the form setup utility that can be accessed. Checking the security option will allow the user to access the various security portions of the form setup utility including creating new users.
Updating a Form

If you press either “View”, “Insert” or “Change” on the forms tab, a window is displayed showing the selected form’s properties. If you are not viewing a form any of the property values can be changed.

When defining a form the following properties may be defined or changed:

**Form:** Form is the unique name by which this form is known. This is the value you see when printing a report from the Printer Control program.

**Description:** Description contains more descriptive information about the form being maintained.

**Form Type:** The form type may be defined as either a Standard or Parsed form. A standard form allows you to specify the page layout and overall form information. A parsed form allows you to indicate reformatting that is to be performed. Use a parsed form when defining forms that process a page at a time (payroll checks, accounts payable checks, statements, purchase orders, etc.)
Checking the inactive box allows you to disable the use of a particular form, but allows you to keep the form.

**Tip:** Mark those forms you would like to keep as models inactive. Then copy them to a new form and make your changes in the newly created form.

### Form Setup Tab

The form setup properties indicate the overall size and default font information to be used when printing the report. Both standard report forms and special forms require these properties to be specified.

<table>
<thead>
<tr>
<th>Margins</th>
<th>Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top: 0.2500</td>
<td>Size: 8.5 in. by 11 in.</td>
</tr>
<tr>
<td>Bottom: 0.0000</td>
<td>Width: 5.0000</td>
</tr>
<tr>
<td>Left: 0.2500</td>
<td>Height: 3.0000</td>
</tr>
<tr>
<td>Right: 0.2500</td>
<td>Orientation: Portrait</td>
</tr>
<tr>
<td>Forms Per Page</td>
<td>Copies:</td>
</tr>
<tr>
<td>Across: 1</td>
<td></td>
</tr>
<tr>
<td>Down: 1</td>
<td></td>
</tr>
<tr>
<td>Check Number Digits:</td>
<td>Paper Bin: Default</td>
</tr>
<tr>
<td>Report Font: Font... Arial, 8</td>
<td></td>
</tr>
</tbody>
</table>

The form margins indicate the overall margins to be used when printing the filed report. All sizes are entered in inches and are accurate to 1/1000 of an inch.

Changing the forms per page option allows you to use one page of the filed report to fill multiple forms in the printed page.

Entering a number into this field forces the printed check number in the form to occupy the indicated number of digits. For example, entering 6 into this field would print check 101 as 000101.

The “Font” button specifies the default font to be used for the printed report. Font color can also be specified.

**Tip:** Standard report forms should always be defined with a non-proportional font.
The paper size properties define the size and orientation of the printed report. Current sizes supported are 8½ by 11, 8½ by 14 or Custom. When specifying a custom form size, the overall width and height of the resulting form must be specified. All sizes are entered in inches and are accurate to 1/1000 of an inch. Orientation is either portrait or landscape.

➤ Note: Custom form sizes are not supported by all printer drivers. This option is primarily useful for dot matrix type printers.

Setting the copies property allows you to specify how many copies are to be produced when printing the form.

➤ Tip: For special forms you can selectively disable the printing of various controls on the second printed copy. This is especially useful when printing checks.

Setting the paper bin allows you to select the bin from where the paper is to be pulled when printing the form.

### Parsed Fields Tab

The tab containing the parsed fields is only available when the parsed option is selected in the main report properties window. The fields in this tab are used when you want to manually define the controls you want to place on the form.

Use the Design button from the main window if you wish to display and change a report using a graphical representation of the produced report. See the next section for a full description of the report designer.
Use the following buttons to maintain the various controls that have been defined for the form.

These maintenance buttons look at (view) a control, add (insert) a new control, create a duplicate (copy) of an existing control, or remove (delete) a control that is no longer used.

➤ **Tip:** Use the “Copy” function to create a new control from an existing control. This shortcuts the time required in setting up new forms.

These buttons allow you to rearrange the order in which the parsed fields are placed on the form. The order has no impact on the produced report, but changing the order may simplify any on going maintenance of the form.

### Security Tab

<table>
<thead>
<tr>
<th>Form Setup</th>
<th>Parsed Fields</th>
<th>Security</th>
<th>Endowment</th>
<th>Calculations</th>
<th>EFT Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name:</td>
<td></td>
<td>Report Name:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes Password:</td>
<td></td>
<td>Yes Password:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Delete:</td>
<td></td>
<td>Auto Delete:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Payee:</td>
<td></td>
<td>Log Payee:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address:</td>
<td></td>
<td>Address:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check:</td>
<td></td>
<td>Check:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amount:</td>
<td></td>
<td>Amount:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
<td>Date:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous:</td>
<td></td>
<td>Miscellaneous:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The tab containing the security fields is only available when a parsed form is being defined. The fields in this tab control various aspects of this form’s usage.

**Report Name:**  
Enter a report name filter in this field. This restricts access to this form to those reports that match the entered value.

**Password:**  
Checking the password option allows you to specify a password that must be entered before the form can be used.

**Auto Delete**  
Select the auto delete option to tell **Advanced Printer Control** the disposition of the report once it has been printed. You may choose “Never” to never delete the report automatically. Choosing “Confirm” requires you to confirm the deletion of the report and “Always” will always remove the report automatically.

➤ **Note:** Deleting the report permanently removes the report. If the printer jams and you have already deleted the report, you will not be able to reprint the report.
Checking the log option causes each use of the form to be logged.

For each page of original filed report you must specify where the various pieces of information that are to be logged is located. For each field the row, column and length of where the data is located is entered. This is entered as follows:

\[ e(\text{row}, \text{column}, \text{length}) \]

For the address field, each line of the address needs to be extracted. This is specified by extracting each line and combining them as follows:

\[ e(\text{street1}) \& \text{nl} \& e(\text{street2}) \& \text{nl} \& e(\text{city}) \]

Be sure to specify the row, column and length for street1, street2 and city when entering the above command.

For the check number field the information located in the generated checks contain more than just the check number. So that the logged information contains ONLY the check number two special functions have been created. These functions will allow you to log the appropriate check number and are entered as follows:

\[ \text{APCheck}(\text{row}, \text{column}, \text{length}) \]

Or for payroll:

\[ \text{PRCheck}(\text{row}, \text{column}, \text{length}) \]

---

**Endowment Tab**

<table>
<thead>
<tr>
<th>Form Setup</th>
<th>Parsed Fields</th>
<th>Security</th>
<th>Endowment</th>
<th>Calculations</th>
<th>EFT Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Endowment Form Type:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>☐ Check. ☐ Acknowledgement ☐ Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Option</td>
<td></td>
<td></td>
<td>One Form Per Page</td>
<td>Lookup:</td>
<td>Row: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>One Form Per CC</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>One Form Per Lookup</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>One Per Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>One Per Distribution Donor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distribution Logging:</td>
<td></td>
<td></td>
<td>☑ Log</td>
<td>Distribution:</td>
<td></td>
</tr>
<tr>
<td>Row:</td>
<td>1</td>
<td>Check:</td>
<td>[\text{APCheck}(27,62,20)]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lines:</td>
<td>1</td>
<td>Amount:</td>
<td>[e(31,65,19)]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date:</td>
<td>[e(31,51,12)]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Choosing the Endowment Form Type allows you to determine which CC addresses are to be printed on the form. Choose other if all CC addresses will be printed.

You may choose how the forms are to be generated. Valid options are:
Using Advanced Printer Control

- **One Form Per Page**
  Selecting the one form per page option causes one form to be generated for each page of report generated by the accounting system.

- **One Form Per CC**
  Choosing the one form per CC option causes a form to be printed for each CC (depending on the Endowment Form Type). In addition an extraction expression must be entered. The extraction expression is used to look up the donor whose CC addresses are to be printed on each form.

- **One Form Per Lookup**
  With the one form per lookup option, the Advanced Printer Control will cause the extraction expression to be repeated for each of the indicated rows. For each donor found a form will be generated.

- **One Per Distribution**

- **One Per Distribution Donor**

- **Log**
  - **Row:**
  - **Lines:**
  - **Distribution:**
  - **Check:**
  - **Amount:**
  - **Date:**
  Check the log distribution to log checks that have been issued into the Endowment Management Suite. Enter the starting row and number of lines if you are issuing a single check for multiple distributions, otherwise leave 1 in the row and lines.

  For each page of original filed report you must specify where the various pieces of information that are to be logged is located. For each field the row, column and length of where the data is located is entered using the same expression syntax used in the security tab. For more information about the expression see the Security Tab in this section.

For more information on how this is used see the Endowment Management Suite documentation.
Calculations Tab

By selecting one of the maintenance buttons (“Insert” or “Change”) the following window is displayed:

Source:
Expression:
Variable:
Expression:
EFT Information Tab

Form Setup | Parsed Fields | Security | Endowment | Calculations | EFT Information

- **EFT**
  - Print form for any generated EFT

**Account Type:**
- Checking
- Saving

**Originating Bank:**
- Status Code: 0
- Number:

**Immediate Destination Information:**
- Name: DestName
- Number: DestNbr

**Immediate Origin Information:**
- Name:OriginName
- Number:OriginNbr

**Your Information:**
- Name: MyName
- Number: MyNumber
- Account: MyAccount

Comment: Test

Use the information entered into this window when generating the EFT transmittal. Checking the EFT option activates this feature. For the transmittal to be successful you must also make sure that form logging is activated (See section on Security Tab).

The values entered into this window are dependent upon the information your bank requires. Please work with your consultant and a bank representative to correctly enter the values required.

**Changing a Control**

When you press either “Insert” or “Change” on the Parsed Fields tab, a window is displayed showing the selected controls properties. This window is also displayed from the forms designer by selecting an element of the form, using the right mouse button and selecting properties. If you are not viewing a form any of the controls property values can be changed.
Control Type:

- **Field**: The control type defines the type of information to be placed in the resulting form. Several choices are available, and the additional properties that are available are dependant upon the type of control being defined.

- **AP Check Number** and **PR Check Number** are used to define information that is to be extracted from the filed report.

- **Text**: is any arbitrary text that needs to be printed on the resulting form.

- **Image**: is a graphic image that is to be printed in the resulting form.

- **Box**, **Vertical Line** and **Horizontal Line** allow you to draw simple forms.

- **Lookup**: is used with the *Endowment Management Suite* or to do complex formatting.

The control type defines the type of information to be placed in the resulting form. Several choices are available, and the additional properties that are available are dependant upon the type of control being defined.

“Field”, “AP Check Number” and “PR Check Number” are used to define information that is to be extracted from the filed report.

“Text” is any arbitrary text that needs to be printed on the resulting form.

“Image” is a graphic image that is to be printed in the resulting form.

“Box”, “Vertical Line” and “Horizontal Line” allow you to draw simple forms.

“Lookup” is used with the *Endowment Management Suite* or to do complex formatting.
Field Control Properties

For “Field”, “AP Check Number” and “PR Check Number” control types, the following specific properties are defined:

Field Name: The field name is arbitrary. This is for your information and not required by the system.

➢ Tip: A field may be “Parsed” more than once. This allows you to create Stub / Stub / Check or any derivative type forms.

Row: The row, column and length indicate the location of the field in the filed report. Lines are counted from the top of the page and start over at the beginning of the next page.

➢ Tip: Edit a sample of a filed report using an editor that displays the row and column. This will simplify determining how the report is to be parsed.

Lines: By specifying a value greater than one a column of information can be extracted and placed in the resulting form.

Text Control Properties

For a “Text” control type the following specific properties are defined:

Text: The information entered is one or more lines of text to be printed on resulting form.
**Image Control Properties**

For an image control type the following specific properties are defined:

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Text:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>tprologo.gif</td>
</tr>
</tbody>
</table>

Text: The text contains the path to the image. Any bitmap (.BMP), PaintBrush (.PCX), Graphic Interchange Format (.GIF), JPEG (.JPG), or windows metafile (.WMF) can be used as an image.

**Drawing Control Properties**

For “Box”, “Vertical Line” or “Horizontal Line” control types the following specific properties are defined:

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Line Width:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>0.0100 inches</td>
</tr>
</tbody>
</table>

Box controls must be specified before any text is printed within the box.

Line Width: Enter into the line width the width of the line to be used for the drawing control.

Fill Color: Press the “Fill Color” button to select the color of the box. This is only specified for a “Box” control. When the box control is initially created the fill color is transparent. Once you press the “Fill Color” button a color must be selected. If you desire a clear background select the color white.

**Lookup Control Properties**

The “Lookup” control type accesses the *Endowment Management Suite* information or provides additional formatting.

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Field Name:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lookup</td>
<td>e(32.8,78), 'Dollars', 'Dollars', 'Cents', 'Pence'</td>
</tr>
</tbody>
</table>

Field Name: The field name contains the name of the *Endowment Management Suite* field to be printed or the additional formatting to be performed.
For the Extract field enter an expression that will locate the Endowment Management Suite field. This is entered as follows:

\[ e(\text{row}, \text{column}, \text{length}) \]

The row, column and length indicates in the original filed report where the information is located.

**Other Control Properties**

The following control properties always appear. If a field is not used for a particular control type it will be disabled.

- **Position**
  - At X: 0.0000 inches
  - At Y: 3.5500 inches

- **Size**
  - Width: 3.0000 inches
  - Height: 0.2500 inches

- **Justification**
  - Default
  - Left
  - Right
  - Center
  - Decimal
  - Offset: 0.0000 inches

- **Usage**
  - All Copies
  - On First Copy
  - Not on First Copy
  - Condition

The position field determines the position of the control in the resulting form. The X position is measured from the left margin in inches. The Y position is measured from the top margin in inches.

The size field determines how big the resulting control will be. All sizes are in inches. There is no problem with overlapping one control with another, as controls are always printed transparently.

Justification is used to define how the control is formatted in the resulting report. Decimal justification will align the decimal points with the offset specified. Offsets are measured from the left for “Default”, “Left” and “Center” justification and from the right for “Right” and “Decimal” justification.

The copy usage allows you to specify when a particular control is to be printed. Use “Condition” to specify an arbitrary condition.

- **Tip:** Use this option to disable printing of the bank account number, signature image, etc. on the second copy of a check.

- **Tip:** To specify an arbitrary condition (see the following section on Signature Logic), logging must be active for the form being designed.

Press the “Font” button to override the font, style, size and color for this particular control.

- **Tip:** The check number, bank account number and routing information on the bottom portion of a check must be printed using a special font installed with the software. This font contains the numbers 0 through 9 and the following special symbols:
  - Use the letter “$”
  - Use the letter “%”
  - Use the letter “&”
** Use the letter “D”
Report Designer

Pressing the “Design” button from the parsed fields tab will display a graphical report designer. The screen shows how a produced page of the form will be displayed. There will be slight differences between the displayed form and the final produced form.

This button accepts all the changes and closes the designer window.

After selecting a control pressing the properties button will display the Update Control window. Here any of the controls properties can be changed.

The delete button can be used to remove one or more selected controls.

The “Left”, “Right”, “Top” or “Bottom” alignment buttons can be used to reposition two or more selected controls. All controls will be aligned to the first selected control highlighted with a red box.
Any of the drawing objects can be “dragged” from the toolbar onto the form. The types of drawing objects (from left to right) are:

- Field
- Text
- AP Check Number
- Image
- Box
- Vertical Line
- Horizontal Line

These correspond to the control types as described in the Changing a Control section.

### Snap to Grid
Choosing the Snap to Grid option causes any dropped or selected control to align to the specified grid.

### Show Grid
Choosing the Show Grid option will display the requested alignment grid.

The grid sizes are 1/8, 1/4, 1/2, or 1 inch increments.

Any of these functions can be accessed from the Edit menu or by using the right mouse button.

➤ **Note:**

A control is selected by clicking on the object shown in the window. The selected control will be highlighted with a red box.

Additional controls can be selected by holding down the CTRL key on your keyboard and clicking on the additional controls. Additional controls will be highlighted with a blue box.

### Pasting Fields From the Browse Window
A field can be directly pasted from the “Browse Reports” window. To use this feature browse the report and copy the field desired into the windows clip board. In the “Report Designer” window press the right mouse button. The following menu is displayed:

Choose the “Paste Field” option to paste the field into the report designer. Once the field has been pasted into the designer, change the field’s properties by selecting the field and pressing the “Properties” button.

The “Paste Field” option will not be available unless the field was copied through the “Browse Report” window. See the Browsing Reports section in Chapter 3 for more information.
Signature Logic

Sometimes it is desirable for signatures (an image) or other text to be printed if a certain condition is met. This capability is available by defining the condition that must be met before the image is printed. The condition can be any valid expression, when evaluated, that results in either true or false.

For signature logic to work you must first enable form logging from the security tab of the form. Change the property of the element being placed on the form and choose “Condition” from the available usage options. In the “Condition” field enter a valid expression. You have access to the following information in the expression:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccountType</td>
<td>Type of account being for this payee. The value will be either “Checking” or “Saving”.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount of the check being printed.</td>
</tr>
<tr>
<td>Check</td>
<td>Check number.</td>
</tr>
<tr>
<td>Date</td>
<td>Date of the check.</td>
</tr>
<tr>
<td>EFT</td>
<td>Indicates that type of check being produced for this payee. The value will be “Check”, “Prenote” or “EFT”</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Any miscellaneous information that has been logged with the check</td>
</tr>
<tr>
<td>Payee</td>
<td>To whom the check is being written.</td>
</tr>
</tbody>
</table>

Examples

These examples are valid conditions:

- \( \text{Amount} > 1000.00 \)  
  Print only if the amount of the check is greater than $1,000.00.

- \( \text{Amount} > 1000.00 \ \text{AND} \ \text{Amount} < 10000.00 \)  
  Print only if the amount is between $1,000.00 and $10,000.00.

- \( \text{Payee <> 'Sample'} \)  
  Print only if the Payee is not “Sample”.

➤ Note: Use single quotes around text fields. Use the following symbols for comparison:

- \( = \) Equal
- \( <> \) Not equal
- \( > \) Greater than
- \( < \) Less than
- \( >= \) Greater than or equal
- \( <= \) Less than or equal
Chapter 4 - Using Web Reporter

Introduction

The Web Reporter allows you to index and sort any generated report. Once the report is indexed, it can then be published as an HTML formatted web page or automatically sent as a series of emails.

The best way to get started is to determine how many and what each level of the resulting collated report is to contain. For the samples provided with the application we chose the following:

Level 1

For the first level of the collated report we want to list each of our department heads. This way, when the report is printed, we only need to burst the report into two pieces when we disburse the report. (We only have two department heads)

Level 2

Since each department head manages more than one fund we want the second level of the report to be the fund number and name. This will be derived from the report contents.

Level 3

We are also combining several reports together and therefore we want this level of the collated report to contain the name of the report.

This is how we want the resulting collated tree to look:

The last level of the report is always implied to be the actual page of the report.

A complex problem with our planned report is the funds that are managed by our department heads are not in sequential order. To solve this problem we need to use the “Condition” to determine when the page of the report belongs to a specific department head.

In addition to sorting the report by department head and then department, we want to discard the report selection page. This is also achieved by using a condition to select the pages of the report desired.

Finally, in looking at the sample, we need to understand conditions and expressions. These act very much like spreadsheet macros and allow you to look at and manipulate the data that exists in the report. In the sample below the “E” command tells the system to extract data from a page of the report at the specified row, column and length.
Method 1

One method for doing this is to define a level 1 collating rule for each possible department. The table below shows how the report collating rules could look:

<table>
<thead>
<tr>
<th>Level</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '00'</td>
<td>'George Snelling'</td>
</tr>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '01'</td>
<td>'Nancy Drew'</td>
</tr>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '02'</td>
<td>'George Snelling'</td>
</tr>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '03'</td>
<td>'George Snelling'</td>
</tr>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '04'</td>
<td>'Nancy Drew'</td>
</tr>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select' AND e(4,1,2) = '90'</td>
<td>'Nancy Drew'</td>
</tr>
<tr>
<td>2</td>
<td>e(1,109,6) = 'Select'</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>e(1,109,6) = 'Select'</td>
<td>'General Ledger'</td>
</tr>
</tbody>
</table>

**Note:** The condition e(1,109,6) = ‘Select’ ensures that blank pages are skipped.

Single quotes are used to surround text constants.

The value is only used for the level if the condition is true.

Method 2

The above set of collating rules work and are easy to understand. Another way the same set of results can be achieved is with this set of rules:

<table>
<thead>
<tr>
<th>Level</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E(1,109,6) = 'Select' AND INLIST(e(4,1,2), '00', '02', '03')</td>
<td>'George Snelling'</td>
</tr>
<tr>
<td>1</td>
<td>E(1,109,6) = 'Select' AND INLIST(e(4,1,2), '01', '04', '90')</td>
<td>'Nancy Drew'</td>
</tr>
<tr>
<td>2</td>
<td>E(1,109,6) = 'Select'</td>
<td>E(4,1,50)</td>
</tr>
<tr>
<td>3</td>
<td>E(1,109,6) = 'Select'</td>
<td>'General Ledger'</td>
</tr>
</tbody>
</table>

With this method, the INLIST function evaluates to true if the department (extracted using e(4,1,2)) is any of the listed values.

Method 3

With the prior methods each department’s section of the report can only be sent to one recipient. A final way to distribute this same report is to create a distribution table. With this method, who receives each section of the report is based on a separately maintained distribution list. The rules for this method are as follows:

<table>
<thead>
<tr>
<th>Level</th>
<th>Condition</th>
<th>Distribution</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E(1,109,6) = 'Select'</td>
<td>Department</td>
<td>E(4,1,2)</td>
</tr>
<tr>
<td>2</td>
<td>E(1,109,6) = 'Select'</td>
<td></td>
<td>E(4,1,50)</td>
</tr>
<tr>
<td>3</td>
<td>E(1,109,6) = 'Select'</td>
<td></td>
<td>'General Ledger'</td>
</tr>
</tbody>
</table>

In the first level the Department distribution list tells the system what the value for the first level of the report will be.
Web Reporter

All features of the Web Reporter are accessed through the main application interface.

Use the toolbar to access the most commonly used functions:

Pressing the “Exit” button will exit you from the Web Reporter.

Press the “Import” button to bring a report or group of reports into the Web Reporter.

Pressing the “New” button will clear the current collated report from the Web Reporter.

Once all the reports have been imported into the application pressing the “Print” button will print all or a portion of the indexed report.
The indexed reports can be published as a series of web pages. Pressing the “HTML” button will post the translated report pages to the specified folder.

If a distribution list has been defined, pressing the “Email” button will allow one or more reports to be distributed each associated recipient.

Pressing the “About” button will display program information regarding to whom this product is licensed as well as current version information. If your product is not yet registered this button will read “Register” and is used to register the software.

In addition to the toolbar many of these functions can also be accessed from the file menu.

From the file menu use the “Configure Reports and Groups” option to maintain your report collating rules and group definitions. Groups are used to simplify the report importing process.

The “Maintain Distribution Lists” function is used to setup and change the recipients for the indexed report, without having to change any collating rules.

You can also change the directory where the reports are located via the “Change Directory” option.

Use the “Options” menu to change and set various HTML publishing and Email options.
Configure Reports and Groups

After selecting “Configure Reports and Groups” from the file menu the following window is displayed:

Or press the “Groups” tab to see the defined report groups.
All maintenance functions, for both reports and groups, are accessed from the above shown windows. Press any of the following buttons for a particular function:

- **List** button will produce a list of all defined report collating rules or groups.
- After completing your maintenance functions pressing the “Close” button will close the “Configure Reports and Groups” window.
- Select an entry from the list of reports or groups and press any of the maintenance buttons to perform that function.

- **Copy** button takes the highlighted report and creates a duplicate. Use this function if you want to make a copy of an existing report’s collating rules to use as a starting point.
**Update Report**

Pressing one of the maintenance buttons ("View", "Insert" or "Change") from the list of reports will display the following window:

![Update Report Window](image)

From this window the following fields are maintained:

**Report**

Enter the name of the filed report. This name must match the name exactly as it appears in the list of filed reports. Wild cards ("*" or "**") will not be processed.

**Description**

Enter a description for the report. A report may have more than one set of collating rules. Use the description to logically separate the different reports from each other.

**Update Page Number in Collated Report**

Checking this option causes the collator to update the page number in the collated report with the collated report page number. You should place the page number over the location of the original page numbers. This will minimize confusion when looking at the printed collated report.

**Row**, **Column**, **Length**

Indicate the location of the page number to be updated by specifying the row, column and length of the page number in the original (and resulting collated) report.

**Publish Individual HTML Trees**

Checking this option and entering an appropriate level will cause the indexed report to be published to specific folders or email to specific recipients.
Level

The level within the indexed report at which individual folders or email recipients have been defined.

Report Collating Rules Tab

<table>
<thead>
<tr>
<th>Level</th>
<th>Condition</th>
<th>Distribution List</th>
<th>Value</th>
<th>Target Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>e(1,109,6) = 'Select'</td>
<td>Fund</td>
<td>e(4,1,2)</td>
<td>Default</td>
</tr>
<tr>
<td>2</td>
<td>e(1,109,6) = 'Select'</td>
<td>&lt;none&gt;</td>
<td>e(4,1,50)</td>
<td>'Chart of Accounts'</td>
</tr>
<tr>
<td>3</td>
<td>e(1,109,6) = 'Select'</td>
<td>&lt;none&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

An unlimited number of collating rules may be defined.

Select an entry from the list of collating rules and press any of the maintenance buttons to perform the requested function.

The copy button takes the highlighted collating rule and creates a duplicate. Use this function if you want to make a copy of an existing rule to make changes.

Note: Selecting a collating rule and using a right mouse click will allow you to get to any of the maintenance functions.
Update Collating Rule

If “Insert” or “Change” is pressed from the Report Collating Rules Tab the following window is displayed:

The “Update Collating Rule” window defines a single level within the resulting collated report. For each level an index or sort value is defined. In addition an optional condition can be specified indicating when this particular level and sort value is to apply.

- **Level**: Level number for resulting sort value. This determines where in the collated report tree this value is to be placed.
- **Condition**: Condition upon which this level is to be created. This is an evaluated field. See Chapter 4 of the table of contents for the section on Evaluated Fields for a description of how these fields work.
- **Distribution**: The distribution table is to be used for this level of the report. Choose “<none>” if this level does not need a distribution list.
- **Value/Location**: Resulting index or sort value for collated tree. This is an evaluated field. See Chapter 4 of the table of contents for the section on Evaluated Fields for a description of how these fields work.
- **Target Path**: Path where this level of the report is to be published. If you are emailing the report and not publishing as an HTML page, enter “Default” into this field.
Update Group

Pressing one of the maintenance buttons ("View", "Insert" or "Change") from the list of groups will display the following window:

From this window, the following fields are maintained:

- **Group**: Enter the name of the group.
- **Description**: Enter a description of the group.
- **Inactive**: Marking a group inactive leaves the group within the system but removes it from the list of groups that can be used for import.

Pressing the "Insert" button adds the selected report to the group. The "Delete" button removes the selected report from the group.
Importing Reports

Pressing the “Import” button or selecting the “Import” option from the file menu will display the following window:

![Import Window]

Here you can select a group of reports (by group name) or an individual report to be imported. An import can be done multiple times each time bringing in a different set of reports. The results are displayed in the main application window.

Printing Reports

Pressing the “Print” button or selecting the “Print” option from the file menu will display the following window:

![Print Window]

Here you indicate the form and page selection to be used when printing the collated report. Use the Advanced Printer Control to define which forms to use in printing the collated report.

You may also indicate a table of contents is to be printed. The table of contents will include all collated levels and their associated page number.
Publishing Reports

Pressing the “HTML” button or selecting the “HTML” option from the file menu will display the following window:

![Save as HTML pages dialog box]

Enter the root folder where the report index page is to be generated and the name for the main index page.
Emailing Reports

Pressing the “Email” button or selecting the “Email” option from the file menu will display the following window:

![Email window]

For each individual in your distribution list, a separate PDF report is created and the specified email is sent.
Evaluated Fields

An evaluated field allows you to manipulate information in a fashion that is similar to a spreadsheet calculation. You can add additional text and manipulate the report being processed. To do this use the concatenation operator (&) to combine character strings together. You can also denote the hierarchy of a particular operation through the use of parenthesis. For example:

‘Hello’ & UPPER(‘World’)

This results in a character value of HelloWorld.

The following table describes the character functions available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLIP(expression)</td>
<td>Remove trailing spaces from expression.</td>
</tr>
<tr>
<td>LEFT(expression [,length])</td>
<td>Left justify expression. Optionally you may indicate the length of the result.</td>
</tr>
<tr>
<td>RIGHT(expression [,length])</td>
<td>Right justify expression. Optionally you may indicate the length of the result.</td>
</tr>
<tr>
<td>CENTER(expression [,length])</td>
<td>Center expression. Optionally you may indicate the length of the result.</td>
</tr>
<tr>
<td>SUB(expression, position, length)</td>
<td>Return a portion of an expression. You must indicate the starting position and length of the portion of the expression desired.</td>
</tr>
<tr>
<td>UPPER(expression)</td>
<td>Convert expression to uppercase.</td>
</tr>
<tr>
<td>LOWER(expression)</td>
<td>Convert expression to lowercase.</td>
</tr>
<tr>
<td>INLIST(expression, value1, [value2 … value16])</td>
<td>Verify that the expression is in the list of values. Up to 16 values may be scanned.</td>
</tr>
<tr>
<td>E(row, column, length)</td>
<td>Extract from report being collated the information defined by the specified row, column and length. This is the primary method for extracting data.</td>
</tr>
<tr>
<td>ES(row, col, length, ‘name’)</td>
<td>Extract from report and save information for later processing using the indicated ‘name’.</td>
</tr>
<tr>
<td>S(‘name’)</td>
<td>Retrieve the current value for the saved information called ‘name’.</td>
</tr>
<tr>
<td>SV(‘name’, ‘value’)</td>
<td>Set the indicated ‘name’ to the specified ‘value’.</td>
</tr>
</tbody>
</table>
For condition evaluated fields you have the ability to indicate the type of condition you wish to test. The valid conditions are:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>expression1 &lt;&gt; expression2</td>
<td>Condition is true if the expressions are not equal to each other.</td>
</tr>
<tr>
<td>expression1 = expression2</td>
<td>Condition is true if the expressions are equal to each other.</td>
</tr>
<tr>
<td>expression1 &gt; expression2</td>
<td>Condition is true if the value of expression1 is greater than expression2.</td>
</tr>
<tr>
<td>expression1 &gt;= expression2</td>
<td>Condition is true if the value of expression1 is greater than or equal to expression2.</td>
</tr>
<tr>
<td>expression1 &lt; expression2</td>
<td>Condition is true if the value of expression1 is less than expression2.</td>
</tr>
<tr>
<td>expression1 &lt;= expression2</td>
<td>Condition is true if the value of expression1 is less than or equal to expression2.</td>
</tr>
</tbody>
</table>

You may make a more complex expression by using AND and OR as well as using parenthesis.
Chapter 5 - Using EFT Transmittal

The EFT Transmittal interface is an optional component that can be used to build a NACHA standard transmittal for electronic payment of vendors. Check with your bank representative about this service and the required formatting.

In order to use this feature you must first enable check logging for each check to be sent to the bank. See the Security Tab section in Update Form for more information about how to activate this feature.

You must define your transmittal information in the form used to print the checks. See the EFT Information Tab section in Update Form for more information about the required information.

Finally, for those vendors you wish to pay electronically, enter the vendors bank and account information. See the Payees Tab section in Chapter 3 for more information about the required information.
As checks (and vendors setup with EFT) are printed the required information is automatically recorded into the Advanced Printer Control. To generate the transmittal file select Generate EFT Transmittal from your windows start menu. The following window is displayed:

If this is the first time you have used this program the “About” button will indicate “Register”. The software must be registered before it can be used.

Fill in the requested information and press OK to generate the file. A report is produced allowing you to verify the information about to be transmitted. The name entered as the “Export Filename” will need to be transmitted to your bank.
Chapter 6 - Using Check Notification

The Check Notification interface is an optional component used to build a transmittal to your bank of all checks issued. Check with your bank representative about this service and the required formatting.

In order to use this feature you must first enable check logging for each check to be sent to the bank. See the Security Tab section in Chapter 3 for more information about activating this feature.

As checks are printed the required information is automatically recorded into Advanced Printer Control. To generate the transmittal file select Check Notification from your windows start menu. The following window is displayed:

If this is the first time you have used this program the “About” button will indicate “Register”. The software must be registered before it can be used.

Fill in the requested information and press OK to generate the file. A report is produced allowing you to verify the information about to be transmitted. The name entered as the “Export Filename” will then need to be transmitted to your bank.
Because each bank uses a different format for reporting checks press the “Configure” button to define the export format. After pressing the button the following window is displayed:

### Update Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check</td>
<td>Check number issued.</td>
</tr>
<tr>
<td>CheckDate</td>
<td>Date of check. This is stored as a number and needs to be formatted as required by your bank.</td>
</tr>
<tr>
<td>Payee</td>
<td>Name of payee on issued check.</td>
</tr>
<tr>
<td>Amount</td>
<td>Dollar amount of check.</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Any miscellaneous information recorded with the check.</td>
</tr>
<tr>
<td>CheckCount</td>
<td>Count of all checks issued.</td>
</tr>
<tr>
<td>CheckTotal</td>
<td>Dollar total of all checks issued.</td>
</tr>
</tbody>
</table>
Formatting Numeric Fields

To facilitate formatting amounts and dates, a FORMAT function is provided. This function formats either dates or numbers. The syntax for the format command is FORMAT(field, picture). The picture for numeric fields are as follows:

All numeric pictures begin with “@N” and are indicated as follows:

@N [currency] [sign] [fill] size [grouping] [places] [sign] [currency] [B]

Each piece of the picture is used as follows:

**currency**

The currency is either a dollar sign ($) or any string constant enclosed in tildes (~). When it precedes the sign indicator and there is no fill indicator the currency symbol "floats" to the left of the high order digit. If there is a fill indicator, the currency symbol remains fixed in the left-most position. If the currency indicator follows the size and grouping it appears at the end of the number displayed.

**sign**

The sign specifies the display format for negative numbers. If a plus (+) precedes the fill and size indicators positive numbers will display with a leading plus (+) sign and negative numbers will display with a leading minus (-) sign. If a hyphen precedes the fill and size indicators negative numbers will display with a leading minus sign. If a hyphen follows the size, places, and currency indicators, negative numbers will display with a trailing minus sign. If parentheses are placed in both positions negative numbers will be displayed enclosed in parentheses. To prevent ambiguity a trailing minus sign should always have grouping specified.

**fill**

The fill specifies leading zeros, spaces, or asterisks (*) in any leading zero positions. The fill also suppresses default grouping. If the fill is omitted leading zeros are suppressed. Values that can be used are:

- 0 (zero) produces leading zeroes
- _ (underscore) produces leading spaces
- * (asterisk) produces leading asterisks

**size**

The size specifies the total number of significant digits to display. The size also include the number of digits in the places indicator and any formatting characters.

**grouping**

A grouping symbol, other than a comma (the default), can appear to the right of the size indicator to specify a three digit group separator. To prevent ambiguity a hyphen grouping indicator should also specify the sign.

- . (period) produces periods
- - (hyphen) produces hyphens
- _ (underscore) produces spaces
places The places specify the decimal separator symbol and the number of decimal digits. The number of decimal digits must be less than the size. The decimal separator may be a period (.), grave accent (’) (produces periods grouping unless overridden).

. (period) produces a period
’ (grave accent) produces a comma

B The B specifies blank display whenever its value is zero.

The following table shows the various pictures with an example of the resulting value:

<table>
<thead>
<tr>
<th>Picture</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>@N9</td>
<td>4,550,000</td>
</tr>
<tr>
<td>@N_9</td>
<td>4550000</td>
</tr>
<tr>
<td>@N09</td>
<td>004550000</td>
</tr>
<tr>
<td>@N9_</td>
<td>4 550 000</td>
</tr>
<tr>
<td>@N9.</td>
<td>4.550.000</td>
</tr>
<tr>
<td>@N-9.2B</td>
<td>-4,550,000.00</td>
</tr>
<tr>
<td>@N(9.2)</td>
<td>(4,550,000.00)</td>
</tr>
</tbody>
</table>

Formatting Date Fields

All date pictures begin with “@D” and optionally specify a separation character. The following table shows the various pictures with an example of the resulting date:

<table>
<thead>
<tr>
<th>Picture</th>
<th>Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>@D1</td>
<td>mm/dd/yy</td>
<td>10/31/59</td>
</tr>
<tr>
<td>@D2</td>
<td>mm/dd/yyyy</td>
<td>10/31/1959</td>
</tr>
<tr>
<td>@D3</td>
<td>mmm dd, yyyy</td>
<td>Oct 31, 1959</td>
</tr>
<tr>
<td>@D4</td>
<td>mmmmmmmmmmm dd, yyyy</td>
<td>October 31, 1959</td>
</tr>
<tr>
<td>@D5</td>
<td>dd/mm/yy</td>
<td>31/10/59</td>
</tr>
<tr>
<td>@D6</td>
<td>dd/mm/yyyy</td>
<td>31/10/1959</td>
</tr>
<tr>
<td>@D7</td>
<td>dd mmm yy</td>
<td>31 Oct 59</td>
</tr>
<tr>
<td>@D8</td>
<td>dd mmm yyyy</td>
<td>31 Oct 1959</td>
</tr>
<tr>
<td>@D9</td>
<td>yy/mm/dd</td>
<td>59/10/31</td>
</tr>
<tr>
<td>@D10</td>
<td>yyyy/mm/dd</td>
<td>1959/10/31</td>
</tr>
<tr>
<td>@D11</td>
<td>yymmdd</td>
<td>591031</td>
</tr>
<tr>
<td>@D12</td>
<td>yyyyymmdd</td>
<td>19591031</td>
</tr>
<tr>
<td>@D13</td>
<td>mm/yy</td>
<td>10/59</td>
</tr>
</tbody>
</table>
The following table shows some examples using alternate separators:

<table>
<thead>
<tr>
<th>Picture</th>
<th>Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>@D14</td>
<td>mm/yyyy</td>
<td>10/1959</td>
</tr>
<tr>
<td>@D15</td>
<td>yy/mm</td>
<td>59/10</td>
</tr>
<tr>
<td>@D16</td>
<td>yyyy/mm</td>
<td>1959/10</td>
</tr>
<tr>
<td>@D17</td>
<td>Windows control panel setting for a short date</td>
<td>N/A</td>
</tr>
<tr>
<td>@D18</td>
<td>Windows control panel setting for a long date</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Picture</th>
<th>Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>@D1.</td>
<td>mm.dd.yy (Period separator)</td>
<td>10.31.59</td>
</tr>
<tr>
<td>@D2-</td>
<td>mm-dd-yyyy (Dash Separator)</td>
<td>10-31-1959</td>
</tr>
<tr>
<td>@D5_</td>
<td>dd mm yy (Underscore produces space separator)</td>
<td>31 10 59</td>
</tr>
<tr>
<td>@D6`</td>
<td>dd,mm,yyyy (Grave accent produces comma separator)</td>
<td>31,10,1959</td>
</tr>
</tbody>
</table>
Chapter 7 - Using Wells Fargo Interface

The *Wells Fargo Interface* is an optional component used to build a list of checks printed for transmittal to the Wells Fargo banking system. This is used by the bank to determine if a check is to be cleared. Check with your Wells Fargo bank representative about this service.

In order to use this feature you must first enable check logging for each check to be sent to the bank. See the *Security Tab* section of Chapter 3 for more information about activating this feature.

To generate the file containing checks to be cleared, choose the *Wells Fargo Interface* from your windows start menu. The following window is displayed:

![Wells Fargo Interface Window](image)

If this is the first time you have used this program the “About” button will indicate “Register”. The software must be registered before it can be used.

Fill in the requested information and press OK to generate the file. A report is produced allowing you to verify the information about to be transmitted. The name entered as the “Export Filename” will need to be transmitted to your Wells Fargo Bank.